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1 Introduction
The goal of this description is to guide the user quickly through the essential steps
required for commissioning a Quick_Start_Guide_HPT protection device.

This document serves as a first introduction for:

• Engineers in the protection field,

• commissioning engineers,

• people dealing with setting, testing and maintenance of protection and control
devices,

• as well as trained personnel for electrical installations and power stations.

This document is roughly divided into the following parts:

• The “Quick Start – Smart view” chapter describes what is necessary to establish a
connection between a Quick_Start_Guide_HPT protection device and the operating
software Smart view.

Since operating a Quick_Start_Guide_HPT device via HMI can be quite cumbersome
this chapter is recommended for all user types, in particular commissioning
engineers.

• The “Quick Start – HighPROTEC” chapter with all its sub-chapters, offers several
step-by-step tutorials. These introduce you to the basic concepts, with the main
priority set to operations using the HMI (panel) of the protection device.

This chapter is of particular interest for users who want to configure and/or operate a
Quick_Start_Guide_HPT protection device.

• The “Good to Know” chapter is a collection of tips and hints. With these, we hope to
help with some of the questions and problems that the SEG Support is often asked.

• The “How to Configure a Protection Device” chapter is a list of aspects which must
generally be taken into account during the commissioning of a
Quick_Start_Guide_HPT protection device, with the main priority set to the use of
Smart view as configuration software. Please understand that we cannot guarantee
for its completeness, nor can it be a detailed step-by-step description, because the
configuration and commissioning of a protection device depends on your particular
application needs. Therefore this chapter cannot be more than a set of friendly
reminders, targeted at commissioning engineers.

Of course, this three-fold concept has the consequence that some special topics, e. g.
switchgear devices (circuit breakers) appear in each of these parts. We therefore
recommend that beginners read this document in its entirety.

This description is not a replacement for the complete manual. For wiring instructions
and complete descriptions of the protective functions, please consult the Technical
Manual.

No part of this manual is allowed to be reproduced or passed on to others in any form,
unless SEG have approved in writing.

Any repair work carried out on the device requires skilled and competent personnel who
need to be well aware especially of the local safety regulations and have the necessary
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experience for working on electronic protection devices and power installations (provided
by evidence).

CAUTION!

We prepared this information carefully, with focus on “a general use”, and intentionally
as a valuable help. But this is still a showcase: Settings might not fit your application
needs, activities might be dangerous regarding to your application.

NOTICE!

It is, in particular, not intended (and absolutely not possible) to give any explicit advice
with respect to protection settings required for your application. If you feel unsure about
how to configure the protection device, feel free to contact the Customer Support of SEG.

Please understand that you have to take care of the following:

• Prepare your local application for safety aspects before you start working with this
document.

• Transfer all examples given in this document to fit your needs.

We cannot take over any responsibility for any unwanted effect.

We require that managing your application follows all applicable local and international
rules, guidelines and directives, and that all your activities are committed to what is
generally expected from professional work.

Information Concerning Liability and Warranty

SEG does not accept any liability for damage resulting from conversions or changes
carried out on the device or planning (projecting) work, parameter setting or adjustment
changes done by the customer.

The warranty expires after a device has been opened by others than SEG specialists.

Warranty and liability conditions stated in SEG General Terms and Conditions are not
supplemented by the above mentioned explanations.
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1.1 Important Definitions
The types of messages shown below serve the safety of life and limb as well as for the
appropriate operating life of the device.

DANGER!

DANGER indicates an immediately dangerous situation that will result in death or serious
injury if it is not avoided.

WARNING!

WARNING indicates a hazardous situation that can result in death or serious injury if it is
not avoided.

CAUTION!

CAUTION indicates a possibly hazardous situation that can result in minor or moderate
injuries if it is not avoided.

NOTICE!

NOTICE is used to address practices not related to personal injury.

This symbol indicates useful tips and recommendations as well as information for
efficient and trouble-free operation.

Proper Use of the Device and of This Manual

WARNING!

FOLLOW INSTRUCTIONS

Read this entire manual and all other publications pertaining to the work to be performed
before installing, operating, or servicing this equipment. Practice all plant and safety
instructions and precautions. Failure to follow instructions can cause personal injury
and/or property damage.
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WARNING!

PROPER USE

Any unauthorized modifications to or use of this equipment outside its specified
mechanical, electrical, or other operating limits may cause personal injury and/or
property damage, including damage to the equipment. Any such unauthorized
modifications: (1) constitute “misuse” and/or “negligence” within the meaning of the
product warranty thereby excluding warranty coverage for any resulting damage, and (2)
invalidate product certifications or listings.

The programmable devices subject to this manual are designed for protection and also
control of power installations and operational devices that are fed by voltage sources
with a fixed frequency, i.e. fixed at 50 or 60 Hertz. They are not intended for use with
Variable Frequency Drives. The devices are further designed for installation in low-
voltage (LV) compartments of medium voltage (MV) switchgear panels or in de-
centralized protection panels. The programming and parameterization has to meet all
requirements of the protection concept (of the equipment that is to be protected). You
must ensure that the device will properly recognize and manage (e. g. switch off the
circuit breaker) on the basis of your programming and parameterization all operational
conditions (failures). The proper use requires a backup protection by an additional
protective device. Before starting any operation and after any modification of the
programming (parameterization) test make a documentary proof that your programming
and parameterization meets the requirements of your protection concept.

The Self-Supervision Contact (Life-Contact) has to be wired with the substation
automation system in order to supervise and monitor the state of health of the
programmable protective device. It is very important that an alarm annunciation is
driven from the programmable protective device self-supervision contact (Life-Contact)
that requires immediate attention when tripped. The alarm indicates that the protective
device is no longer protecting the circuit and the system should be serviced.

Typical applications for this product family/device line are for instance:

• Feeder protection
• Mains protection
• Machine protection
• Transformer Protection
• Generator Protection

Any usage beyond these applications the devices are not designed for. This applies also
to the use as a partly completed machinery. The manufacturer cannot be held liable for
any resulting damage, the user alone bears the risk for this. As to the appropriate use of
the device: The technical data and tolerances specified by SEG have to be met.
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Out-of-date documentation?

This publication may have been revised or updated since this copy was produced. To
verify that you have the latest revision, please visit the download section of our website.

Please check the web site of SEG for the latest revision of this Technical Manual and if
there is an Errata Sheet with updated information.

• Visit the company website and search for the documents you are interested in. (The
ID of every document is printed on its cover page.)

• Alternatively, every Quick_Start_Guide_HPT device has a QR code printed on it. Scan
this code, and you are taken to an online directory that contains all relevant
documents in the most recent version.

Important Information

WARNING!

In line with the customer’s requirement the devices are combined in a modular way (in
compliance with the order code). The terminal assignment of the device can be found on
the top of the device (wiring diagram).
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CAUTION!

Electrostatic Discharge Awareness

All electronic equipment is electro static-sensitive, some components more than others.
To protect these components from electro static damage, you must take special
precautions to minimize or eliminate electrostatic discharges. Follow these precautions
when working with or near the control.

1. Before doing maintenance on the electronic control, discharge the static electricity on
your body to ground by touching and holding a grounded metal object (pipes, cabinets,
equipment, etc.).

2. Avoid the build-up of static electricity on your body by not wearing clothing made of
synthetic materials. Wear cotton or cotton-blend materials as much as possible because
these do not store static electric charges as much as synthetics.

3. Keep plastic, vinyl, and Styrofoam materials (such as plastic or Styrofoam cups, cup
holders, cigarette packages, cellophane wrappers, vinyl books or folders, plastic bottles,
and plastic ash trays) away from the control, the modules, and the work area as much as
possible.

4. Do not remove any printed circuit board (PCB) from the control cabinet unless
absolutely necessary. If you must remove the PCB from the control cabinet, follow these
precautions:

• Verify the safe isolation from supply. All connectors have to be unplugged.
• Do not touch any part of the PCB except the edges.
• Do not touch the electrical conductors, the connectors, or the components with

conductive devices or with your hands.
• When replacing a PCB, keep the new PCB in the plastic antistatic protective bag it

comes in until you are ready to install it. Immediately after removing the old PCB
from the control cabinet, place it in the antistatic protective bag.

SEG reserves the right to update any portion of this publication at any time. Information
provided by SEG is believed to be correct and reliable. However, no responsibility is
assumed by SEG unless otherwise expressly undertaken.

© 2020 SEG. All Rights Reserved.
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2 Quick Start – Operating Software Smart view
Installation of Smart view

Smart view is the setting and operation software for SEG
protective devices.

It is available on the product DVD that can be ordered from
SEG. The setup program “Smartview_SE_Install.exe” is
contained in the “Smart view SE” folder of the product DVD.

In addition, the Smart view setup can also be downloaded from
the SEG download area: ══▷ wwdmanuals.com/smart_view

• Start the setup program and follow the steps displayed by the setup wizard.

• After the software has been successfully installed it can be launched via: Start →
Programs → SEG → Smart view SE → Smart view
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2.1 Setup of the Connection PC – Protective Device
Smart view can receive data from the protective device only after the connection has
been set up. This needs to be done only once.

The following pages present an overview of the connection setup for the various types of
protective devices.

A detailed description can be found in the Smart view manual, which is available as a
separate document on the product DVD, but can also be accessed directly from the Smart
view Help menu.

2.1.1 Optional Accessories

The type of cable required for the connection is dependent on the type of protective
device. The cables are not part of the product delivery, but can be ordered separately
from SEG.
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USB cable, for protective
devices with USB front
connector.

SEG article:

5450‑1946

Null Modem cable, for
protective devices with RS232
front connector.

SEG article:

COMRS232Nullm

USB/Serial adaptor, for
protective devices with RS232
front connector and PC
without RS232 connector.

SEG article:

USB2RS232ADAP
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2.1.2 Connect a Protective Device to a PC via USB
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USB cable

SEG article:

5450‑1946

SmartV_Z06

• Use the USB cable to connect the PC with the switched on protective device.

• Start Smart view.

• In the “Settings” menu select the menu item “Device Connection…”
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Ready

Shortcuts Device Data

Smart view
File Device Edit View

Device not connected

.... <No Device Data loaded>

Device Connection...
Language...
Display ANSI Device Numbers
Display Shortcuts Window

Settings Tools Window Help

• Select “USB Connection” in the dialog. Then you can pick the connected USB device
from a selection list.
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USB Connection

Connected USB Device at Workstation:

Connection Settings

HelpCancelApply

Serial Connection

USB Connection

Ethernet Connection

HTL3 / PL / WIP Device
Connection

SEG HighPROTEC USB (COM6)

• If this connection is established for the first time you will see a special confirmation
dialog. Click “Yes” to confirm.
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⇨ Finished – The connection has been set up.
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2.1.3 Connect a Protective Device to a PC via Ethernet (TCP/IP)

It is possible to establish an Ethernet TCP/IP connection if the protective device features
an Ethernet connector.

• Connect the Ethernet interfaces of the protective device and the PC with a common
Ethernet network.

• Set (or check) the TCP/IP parameters on the HMI panel of the protective device.
These are accessed via the following menu path:

[Device Para / TCP/IP / TCP/IP config]

First, set »TCP/IP« = “active”.

Then set the »IP address«, »Subnet mask« and the »Default gateway«. (The values
shown below are only an example.)

The values to be entered are dependent on the individual TCP/IP network where the
protective device is connected. If in doubt, ask your network administrator.
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Device Para

Time
Version

TCP/IP
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TCP/IP

Advanced Settings
TCP/IP config
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TCP/IP config
TCP/IP

active

• Start Smart view.

• In the “Settings” menu select the menu item “Device Connection…”
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Ready

Shortcuts Device Data

Smart view
File Device Edit View

Device not connected

.... <No Device Data loaded>

Device Connection...
Language...
Display ANSI Device Numbers
Display Shortcuts Window

Settings Tools Window Help

• Select “Ethernet Connection” in the dialog. Then enter the TCP/IP address of the
protective device into the input field.
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Ethernet Connection

IP Address of the Device:

Connection Settings

HelpCancelApply

Serial Connection

USB Connection

Ethernet Connection

HTL3 / PL / WIP Device
Connection

192.168.2.170

⇨ Finished – The connection has been set up.
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2.1.4 Serial RS232 Connection with Protective Device (up to
Release 2.4)

2.1.4.1 Serial RS232 Connection to a PC

Connect a Protective Device to a PC via Serial RS232 Connector

Sm
ar

tV
_Z

23

Null Modem cable

SEG article:

COMRS232Nullm

SmartV_Z06

• Use the Null Modem cable to connect the PC with the switched on protective
device.

• Start Smart view.

• In the “Settings” menu select the menu item “Device Connection…”
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Ready

Shortcuts Device Data

Smart view
File Device Edit View

Device not connected

.... <No Device Data loaded>

Device Connection...
Language...
Display ANSI Device Numbers
Display Shortcuts Window

Settings Tools Window Help

• Select “Serial Connection” in the dialog. Then you can pick the particular COM port
to which the protective device is connected from the selection list.

17HighPROTECHPT-3.7-EN-QSG

2 Quick Start – Operating Software Smart view
2.1.4 Serial RS232 Connection with Protective Device (up to Release 2.4)



Sm
ar

tV
_Z

09

Serial Connection

Serial Communication Port of Workstation:

Connection Settings

HelpCancelApply

Serial Connection

USB Connection

Ethernet Connection

HTL3 / PL / WIP Device
Connection

COM1 (Communications Port)

• If this connection is established for the first time you will see a special confirmation
dialog. Click “Yes” to confirm.

⇨ Finished – The connection has been set up.
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2.1.4.2 Serial RS232 Connection to a PC without an RS232 Connector

Connect a Protective Device to a PC without a Serial RS232 Connector
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Null Modem cable

SEG article:

COMRS232Nullm
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USB/Serial adaptor

SEG article:

USB2RS232ADAP SmartV_Z06

• Connect the USB/Serial adaptor with a free USB connector of the PC.

• Connect the adaptor with the Null Modem cable and the Null Modem cable with the
switched on protective device.

• Start Smart view.

• In the “Settings” menu select the menu item “Device Connection…”
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Ready

Shortcuts Device Data

Smart view
File Device Edit View

Device not connected

.... <No Device Data loaded>

Device Connection...
Language...
Display ANSI Device Numbers
Display Shortcuts Window

Settings Tools Window Help

• Select “Serial Connection” in the dialog. Then you can pick the particular COM port
to which the protective device is connected from the selection list.
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Serial Connection

Serial Communication Port of Workstation:

Connection Settings

HelpCancelApply

Serial Connection

USB Connection

Ethernet Connection

HTL3 / PL / WIP Device
Connection

COM7 (USB Serial Port)
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• If this connection is established for the first time you will see a special confirmation
dialog. Click “Yes” to confirm.

⇨ Finished – The connection has been set up.
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2.1.5 Receive Settings from the Protective Device

After the connection has been set up it is possible to receive information from the
protective device.

• After a click on the menu item “Device” → “Receive Data from Device” data is
retrieved from the protective device.
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Ready

Shortcuts Device Data

Smart view
File

Device not connected

.... <No Device Data loaded>

Transfer only modified Parameters into the Device...
Transfer ALL Parameters into the Device...

Reset to Parameter "Read Only" Status

Ctrl+F7
F7

Device Edit View Settings Tools Window Help

Receive Data from Device F2

• Smart view establishes a connection with the protective device, reads data from it
and displays these values in form of a tree structure.
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Ctrl . Single Line BusbarFeeder
Module . name Value

Device planning

IH2 . Mode -
I[1] - 50, 51 . Mode -

Device connectedReady

Shortcuts Device Data

Smart view

Operation

Device planning

Device Para

1,0

Field Para

50/60

Protection Para

765

MCDGV4
Operation
Device planning
Device Para
Field Para
Protection Para
Control
Logics
Service

File Device Edit View Settings Tools Window Help

Usually the first step will probably be, as shown above, to select the menu [Device
planning] and decide about the device features – especially the protection functions – to
be used. (For more information on this, see also ╚═▷ “5.2.2 Device Planning”.)
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2.1.6 Change Settings in the Protective Device

• Step 1: Change the setting values:

A protection module that is required can be configured only after it has been
activated. To do this, access the module in the [Device planning] menu branch of the
tree structure and change the value of the »Mode« parameter from “-” (= “do not
use”) to “use”.

Device connectedReady

Shortcuts Device Data

Smart view

Operation

Device planning

Device Para

1,0

Field Para

50/60

Protection Para

765

MCDGV4
Operation
Device planning
Device Para
Field Para
Protection Para
Control
Logics
Service

File Device Edit View Settings Tools Window Help

Sm
ar

tV
_Z

17

Ctrl . Single Line BusbarFeeder
Module . name Value

Device planning

IH2 . Mode -
I[1] - 50, 51 . Mode -

Help

Edit Value

Value Details

forward
I[1] - 50, 51 . Mode

Range of Values: Select a value from drop down

Access Level: Supervisor-Lv3

Phase Overcurrent Stage, general 
operation mode

OK Cancel

Previous

Next

Value Details:
forward

• Step 2: Transfer the changes:

The changed values are used only after they have been transferred to the protective
device: Click the menu item “Device” → “Transfer only modified Parameters into the
Device…”.
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Ready

Shortcuts Device Data

Smart view
File

Device not connected

.... <No Device Data loaded>Transfer ALL Parameters into the Device...

Reset to Parameter "Read Only" Status

F7

Device Edit View Settings Tools Window Help

Receive Data from Device F2

Transfer only modified Parameters into the Device... Ctrl+F7

• This transfer of the changes involves entering the password of the protective device.
After it has been correctly entered the changes are sent to the device (and the
device activates the new settings).

NOTICE!

Note that the standard/default passwords do not represent any serious security level. It is
strongly recommended to modify them to some individual values.
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2.2 Operation via Smart view
Although it is easy and convenient to operate a Quick_Start_Guide_HPT protection device
using the panel, as described in ╚═▷ “3 Quick Start – Operation via Panel”, a full
configuration session with many settings to be made would be a quite cumbersome
activity. For numerous operations, the preferred way is to connect a PC with an operating
software to the protection device, so that everything can be done using computer mouse
and keyboard and the large computer monitor gives a far better overview about the
available menu branches, than is possible with the device's built-in display.

SEG offers an operating software named Smart view. It offers convenient ways to do all
configuration work, reading and evaluating statistical data and measuring values, fault
analysis via event and fault recorder, and much more. A detailed Technical Manual is
available as a separate document.

Setting up the Connection PC - Device

A PC connection can be established either via USB or via Ethernet (if available). (See ╚═▷
“2 Quick Start – Operating Software Smart view” for details.)

Apart from plugging in the required cables, there are essentially two steps to be done for
establishing a connection:

⚙

1. ▷ In Smart view, click on [Settings → Device Connection], then select the type of
connection to be used for the device.

▶ After this, the connection has not been established yet, therefore you should not be
confused by the “ Not connected” message in the status line (see figure below).

2. ▷ Click on [Device → Receive Data from Device] (or, alternatively, press »F2« on your
keyboard, or click on the small icon with the blue arrow pointing rightward).

▶ Smart view should now retrieve the complete menu tree, including all setting values and
run-time data. After that, you should see a menu tree with the same top-level
categories, as we have already described for the panel of the device (see ╚═▷ “3.1 Menu
Structure”).
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MCDGV4

MenuRecMeas

Ready

Shortcuts Device Data

Smart view
File Device Edit View Settings Tools Window Help

Device not connected

.... <No Device Data loaded>

Fig. 1: Connect the PC to the protection device and within Smart view, specify the connection
settings.
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MenuRecMeas

Communication

Device connectedReady

Shortcuts Device Data

Smart view

Operation

Device planning

Device Para

1,0

Field Para

50/60

Protection Para

765

MCDGV4
Operation
Device planning
Device Para
Field Para
Protection Para
Control
Logics
Service

File Device Edit View Settings Tools Window Help

Fig. 2: After you have selected “ Receive Data from Device”, Smart view presents the full menu
tree.
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NOTICE!

If you have never connected to this particular protection device in this firmware version
(release) before then Smart view will probably tell you that a so-called “device model” is
required. This is a set of files which define the menu tree and all parameters, including
factory defaults and setting ranges. The device model is needed by Smart view for
showing the menu tree correctly.

Fortunately, this does not mean any additional problem for the user: Although it is
possible to install device models independently, as a separate installation activity (which
enables to have a look at the menu and parameters without a connection), the most
convenient way is probably to simply accept the offer that Smart view automatically
makes, and let Smart view retrieve the device model directly from the connected device.
This additional download takes only a few seconds and needs to be done only once. (The
device model gets installed on the PC hard drive and is available immediately for all
future connections with this device.)

After the menu tree has been made available within Smart view, all further activities,
such as changing a setting value, are straight-forward (and do probably not need a lot of
detailed explanations): You can expand the (sub-)menu branches of any menu branch
(click on the small triangle next to the menu item, or a double-click on the item name),
until you reach the required bottom-level item. For example, (for a device with 14 LEDs)
for the menu item [Device Para / LEDs / LEDs group A / LED 1]:
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Latched inactive
Ack signal - . -
LED active color green
LED inactive color -
Assignment 1 Prot . active
Inverting 1 inactive
Assignment 2 - . -
Inverting 2 inactive
Assignment 3 - . -
Inverting 3 inactive
Assignment 4 - . -
Inverting 4 inactive
Assignment 5 - . -
Inverting 5 inactive

Name Value

Device Para/LEDs/LEDs group A/LED 1]

Help

Edit Value

Value Details

green
LED active color

Range of Values: Select a value from drop down

Access Level: Supervisor-Lv3

The LED lights up in this color if the 
state of the OR-assignment of the 
signals is true.

OK Cancel
HP

T_
ZB

A

Previous

Next

A double-click opens a small dialog window, which lists all settings in this menu item, and
a double-click on a setting opens another dialog that allows for modifying the settings
value.

Note, however, that any parameter change becomes effective only after it has been
transferred (from Smart view) into the device:

⚙

1. ▷ Click on [Device → Transfer only modified Parameters into the Device] (or, alternatively,
press »Ctrl«+»F7« on your keyboard, or click on the small icon with the blue arrow
pointing leftward).
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⚙

1. ▷ Alternatively, you can select [Device → Transfer ALL Parameters into the Device] (which
corresponds to pressing »F7« on your keyboard, or click on the small icon with many
sheets of paper and the blue arrow pointing leftward).

2. ▷ You are asked for the corresponding password, unless the required access level (in this
case: “Supervisor-Lv3”) is still open.

▶ The settings are transferred into the device and, unless any validity or consistency
problems are detected, are being activated.
Note that Smart view might also ask you whether you want to create a settings file
containing your values, so that you are able to (re-)load all settings at a later time. For
every industry-standard commissioning work, it is always recommended to carefully
archive all changes.

CAUTION!

Clicking [Save] does neither transfer nor activate any changed values (even though the
asterisk tokens disappear). The [Save] menu (and button) does nothing more than saving
your changes to a *.HptPara file. Remember to always also transfer the parameters to
the connected device if you want to activate your changes.
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3 Quick Start – Operation via Panel

3.1 Menu Structure
The menu structure offers the following top-level menu entries. You enter a menu branch
with Softkey ▶. Softkeys ▲ and ▼ let you navigate to the previous or next one.

Operation

HP
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Operation

Here you can find run-time data.

• Measured Values
• Statistics
• Status Display
• Counter and RevData
• Fault recorder, Event recorder, Disturbance recorder
• Self-Supervision
• Acknowledge, reset

Device planning

HP
T_

ZA
M

Device planning

This will usually be your first step during commissioning:

Activate the elements that you need, deactivate elements
that are not needed.

Select the protocol for (SCADA) communication with the
substation.

Device Para
1,0

HP
T_
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N

Device Parameters

This menu branch features all settings that are directly
related to the device, for example:

• Digital inputs and outputs
• LEDs
• Settings for the Recorders
• Communication settings

Field Para

50/60

HP
T_
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O

Field settings

Usually the second commissioning step: Configure the
properties of the field, for example:

• Nominal frequency, voltage, current
• CT and VT ratios
• VT connection type (Phase to Ground, Phase to

Phase)
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Protection Para
765
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Protection Parameters

All protection settings, which are related to a specific
protection function, can be found here.

For each protection function, the settings are grouped
into the following setting types:

• Global Protection Parameter
• Set 1 … Set 4
• PSet-Switch (Switching Parameter Set)

Control

HP
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Q

Control

Settings for switchgear devices.

• The Quick_Start_Guide_HPT devices named  “MR…”
can control 1 switchgear device.

• The Quick_Start_Guide_HPT devices named  “MC…”
can control up to 6 switchgear devices.

Logics
&

≥1
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Programmable Logic

• Up to 80 logic equations
• 4 selectable gates
• 4 inputs, 4 outputs per equation
• timer and memory functions

Service

HP
T_
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S

Service

This menu branch is primarily needed for testing
purposes. For example:

• Force / disarm outputs
• Force / disarm analog input and outputs
• Use the internal signal/fault generator
• Reboot the protection device
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3.2 Navigation via Softkeys
In this section, we demonstrate the use of the panel and how to navigate through the
menu tree. As an explicit example for this, we show how to check the measured values.
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1. Enter Main Menu:

The buttons located directly underneath the
display have a context-dependent meaning.
The function of each key can be seen from the
label that is shown on the bottom row of the
display, directly above the key. Since these
keys have a functionality defined by the
currently active software module they are
called  “Softkeys”.

In the situation shown left, pressing the Softkey
labeled “Menu” takes you into the main menu.
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Operation

2. Enter Menu Branch Operation:

Once the “Menu” Softkey has been pressed
every Softkey gets a new function, which is
displayed via arrow symbols.

In general you have to press the Softkeys “▲”
(Up) and “▼” (Down) repeatedly until the
desired (sub-)menu item is highlighted. Then
pressing the “ ▶” (Enter) Softkey enters the
selected menu item (in this case: Operation).
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Operation

Statistics
Status Display

Measured Values

3. Enter Measured Values:

Let us assume that you intend to check the
measured values, in particular the phase
voltages. After you have entered the
“Operation” menu several submenu items are
displayed, and you enter the submenu branch
“Measured Values”.
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Voltage

VL12
VL23

f

0.00 kV

0.000 Hz
0.00 kV

4. Check Measured Voltages:

After you have entered the sub-menu Voltage
(in the same way) all voltage-related measuring
values are displayed as a list.

If there are more entries than fit on the display
you can use the Softkeys “▲” (Up) and “▼”
(Down) to scroll upwards or downwards the list.

Pressing the Softkey “◀” (Left) repeatedly takes
you back the menu branch (one level with each
press), until you finally come back to the main
menu.
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3.3 Softkey Symbols
The following symbols are used to label the function of a Softkey:

Softkey Meaning

Via Softkey »up« you can scroll upwards. You go to the prior menu point/one parameter
up by scrolling upwards.

Via Softkey »down« you can scroll downwards. You go to the next menu point/one
parameter down by scrolling downwards.

Via Softkey »left« you will go one step back. You can leave the submenu. You go back to
the previous page of menu tree.

Via Softkey »right« you can enter the selected submenu.

Via Softkey »Top of list« you jump directly to the top of a list.

Via Softkey »Bottom of list« you jump directly to the end of a list.

Via Softkey »+« the currently selected digit is incremented. (Continuous pressure: fast
repeat).

Via Softkey »−« the currently selected digit is decremented. (Continuous pressure: fast
repeat).

Via Softkey »left« you select the digit left to the previously selected one.

Via Softkey »right« you select the digit right to the previously selected one.

Via the »Wrench« symbol you can change the selected parameter (i. e. enter the
parameter setting mode).

Via the »Key« symbol you are asked for password authorization, then you can change
the selected parameter.

Via Softkey »delete« the selected data is deleted.

Fast forward scrolling is possible via Softkey »Fast forward«.

Fast backward scrolling is possible via Softkey »Fast backward«.
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3.4 Entering a Password
Most activities require you to enter a predefined password. Several access-levels exist,
and each of these can be given a specific “access-level password”. (See the Technical
Manual for details.) The factory default for all access-level passwords is “1234”.
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Enter Password

Supervisor-Lv3
* * * *

1 2 3 4

Password Entry:

Each Softkey is now labeled with a digit in the
range 1…4.

Use the Softkeys to enter the required
password. On the display, every typed-in digit
is represented by an asterisk “*”.

Finally press the »OK« key.

For new versions of the protection device, there is a special “Reference Manual” available
(in addition to the Technical Manual). It lists all settings and signals available with the
device with their default values and properties. (For older versions of the protection
device, the parameter tables were part of the Technical Manual.) And as already said
above, the access level specifies which password is required for changing the respective
setting value.

If, however, it is preferred to change parameters without entering a password, it is
possible to define a blank password for the respective access level. But be aware that
this can be a potential security risk.
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3.5 Function Keys
Below the Softkeys, there are four keys with fixed labels:

• »INFO« (“information”, see also ╚═▷ “3.6 “INFO” key – Check LED Assignments”),

• »C« (“clear”, see also ╚═▷ “3.8 “C” key – Acknowledge (Reset) Latched Signals,
Output Relays, Trip Commands”),

• »OK« (see also ╚═▷ “3.7 Parameter Changes – “OK” key”,

• »CTRL« (“control”, see also ╚═▷ “3.9 “CTRL” key – Control Switchgear Devices”).
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3.6 “INFO” key – Check LED Assignments

MRA4
MenuRecMeas
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By pressing the »INFO« key you get immediate
information about the active LED assignments.

Press the »INFO« key once to see the
assignments of all LEDs that are positioned left
to the display.

Press the »INFO« key again to see the
assignments of all LEDs that are positioned on
the right side of the display (if available).

QA1.TripCmd
Prot.Alarm
I[1].TripCmd
-.-
-.-

LED Info

QA1.TripCmd
Prot.Alarm
I[1].TripCmd
-.-
-.-
-.-

...

...
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Prot.active

• Each LED assignment is listed in one line
of text per LED, so that you get 7 lines for
the 7 LEDs in a column.

• Devices with a small display feature only a
maximum of 7 lines, which means there is
not enough room for all assignments plus
heading plus Softkey assignments.
Therefore these small displays toggle
every second between two layouts, one
with visible heading and Softkey
assignments (covering some of the LED-
related lines), and the other with heading
and Softkeys being hidden.

• Devices with a big display do not need this
toggling, because the display has enough
room for displaying everything.

• For each LED, only the first assignment is
shown (or “-.-” if there is none). If there is
more than one signal assigned to an LED,
this is indicated by 3 dots at the right
margin: “...”

• Such multiple assignments can be checked
by highlighting the respective line and
pressing the “ ▶” (Enter) Softkey.
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I[2].TripCmd
I[1].TripCmd

-.-
-.-
-.-

This takes you to a new screen, which is
dedicated to only one LED.

Press the Softkeys “▲” (Up) or “▼” (Down) to
select the previous or next LED, respectively.

A (ticked “☑” / unticked “☐”) checkbox next to
each assigned signal indicates whether or not
the signal is currently active. (In the example
shown to the left, the signal »I[2] . TripCmd« is
active, so that LED4, to which the signal is
assigned, is lit.)
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3.7 Parameter Changes – “OK” key
Whenever setting values are being modified the »OK« key is used to make the device
accept the new value. But note that for modifying one value, the »OK« key must be
pressed twice: When pressing »OK« for the first time, the new value is stored temporarily.
Only after it has been pressed for a second time, the new value gets active.
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For example, let us assume we want to modify
the value of »I[2] . Mode«.
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Device planning

This setting can be found in the Device
planning menu branch (which can be seen, for
example, in the Reference Manual). The
purpose of the parameter is to activate (or
deactivate) the protection function »I[2]« (i. e.
the 2nd stage of the Overcurrent protection).

Enter the Device planning menu branch.
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Device planning

ℹ general operation mode

I[2].Mode
-

1. 2.

Then press the “▼” (Down) Softkey repeatedly,
until the required setting can be seen in the
display.

Remark: Directly above the Softkey
assignments, there is a line starting with “ℹ”. It
shows a description of the currently selected
parameter.

Then press the “Key” Softkey to enter the Edit
Mode for this particular setting.
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Enter Password

Supervisor-Lv3
* * * *

1 2 3 4

You are asked for the password. Settings in the
Device planning menu branch require the
Supervisor access level.

Type in the digits for the password using the
Softkeys “1” … “4”, then press the »OK« key.
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-
I[2].Mode

non directional
forward

1.

2.

Press “▼” (Down) repeatedly again, until the
required value, for instance: “non directional”,
is highlighted.

Then press the »OK« key, so that this new value
gets stored (temporarily). (Or, alternatively,
press the »C« key to cancel the modification.)

Note that the new value is only stored
internally, but not active yet.
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Device planning

ℹ general operation mode

I[2].Mode
non directional

⁕
⁕

That first »OK« pressing that you have just
done brings you back to the screen showing the
selected parameter, »I[2] . Mode«.

However, some things have changed now:

• Now the new value “non directional” is
shown.

• An asterisk character “*” next to the
parameter indicates that there are
temporary changes for it. In addition,
another asterisk next to the heading line
indicates that parameter changes exist
that have not yet been accepted and
activated by the device. (The “*” remains
there, even if one navigates to some other
menu branch. See also ╚═▷ “Asterisk
(Star)”.)

• In the top right corner of the display, an
open lock symbol indicates that the
entered password is still effective, i. e. the
respective access level is open.
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Save 
Parameter 
changes?

Save

yesno

?

Press »OK« again. (In principle, this can also be
done later, i. e. after some more parameter
changes and when being in another menu
branch.)

A confirmation dialog asks you to explicitly
accept your changes. Press the corresponding
Softkey for “yes” (or “no” to cancel).

The protection device performs a validity
check, and after this, it uses the new setting
(unless it detects a validity problem).

If the validity check should fail, i. e. the protection device detects some validity problem
or incosistency with respect to the new value(s) then this is indicated by a big “?”
character that appears instead of the “*” in the heading line. In this case the protection
device refuses to activate the new value(s), and you are expected to re-edit the values.
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Protection Para
765

A second example: Let us assume that we have
activated the protection function »I[2]«, i. e. we
set »I[2] . Mode« = “non directional”, as
described in the previous example.

Now, as an example for a numerical parameter,
we want to set the value of the overcurrent
threshold »I[2] . I>« (in parameter set 1).

The menu path for this parameter is:
[Protection Para / Set 1 / I-Prot / I[2]].

(Just like with the previous example, this menu
path can be looked up in the Reference Manual.
However, we are strongly convinced that a
menu path like this is straight-forward, so that
there should be no need to look it up.)

HP
T_

ZB
0

Protection Para
Global Prot Para
PSet-Switch
Set 1

Enter the submenu [Set 1] the same way: Press
“▲” (Up) or “▼” (Down) repeatedly, until “Set 1”
can be seen in the display, then press “ ▶”
(Enter).
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Set 1
I-Prot-50, 51,+...
V-Prot-27, 59,+...
f-Prot-81

Then enter the [I-Prot] sub-menu.
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I-Prot-50, 51,+...

I[2]-50, 51
I[1]-50, 51

Finally enter the [I[2]] sub-menu.
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I[2]-50, 51

ℹ If the pickup value is exceeded, the module/element starts to time out to trip.

I>
...

1. 2.

Press “▲” (Up) or “▼” (Down) repeatedly, until
the parameter »I[2] . I>« can be seen in the
display, then press “ ▶” (Enter).
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I>

AdaptSet 2

DefaultSet
AdaptSet 1

This particular parameter supports Adaptive
Sets. (See ╚═▷ “Adaptive Parameter Sets” for
information, and the Technical Manual for a
detailed description.)

Select the Set which you want to modify. As a
general rule, one always starts with the Default
Set, regardless whether it is intended to also
use Adaptive Sets or not.
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DefaultSet

ℹ If the pickup value is exceeded, the module/element starts to time out to trip.

I>
1.00 In

The previous setting value is shown. As in the
previous example, you enter the Edit Mode by
pressing the “Key” Softkey.
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Enter Password

Prot-Lv2
* * * *

1 2 3 4

You are asked for the password. This parameter
requires the access level “Prot-Lv2”.

Type in the digits for the password using the
Softkeys “1” … “4”, then press the »OK« key.
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I>

01.00 In

Since this is a number value you see a special
numeric editing dialog: A flashing cursor is
underlining one of the digits, and with the
Softkeys “+” or “−” you can increase or
decrease the digit, respectively. The Softkeys
“←” (Left) or “→” (Right) move the cursor one
decimal place to the left or right, respectively.

Finally press the »OK« key, so that this new
value gets stored (temporarily). (Or,
alternatively, press the »C« key to cancel the
modification.)

Note that again, the new value is only stored
internally, but it is not active yet.
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DefaultSet

ℹ general operation mode

I>
1.23 In

⁕
⁕

That first »OK« pressing that you have just
done brings you back to the screen showing the
selected parameter, »I[2] . I>«.

• However, the new value “1.23 In” is now
shown.

• The two asterisk characters “*” indicate
that there are temporary changes, just like
in the previous example.

• In the top right corner of the display, an
open lock symbol indicates that the
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entered password is still effective, i. e. the
respective access level is open.

Press »OK« again. A confirmation dialog asks
you to explicitly accept your changes. Press the
corresponding Softkey for “yes” (or “no” to
cancel).

The protection device performs a validity
check, and after this, it uses the new setting
(unless it detects a validity problem or
incosistency with respect to the new value).
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3.8 “C” key – Acknowledge (Reset) Latched Signals, Output
Relays, Trip Commands
Standard Behavior

MRA4
MenuRecMeas
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The [Acknowledge] menu allows to
“acknowledge” (i. e. reset) latched signals,
output relays and/or trip commands. This menu
branch can be accessed the usual way, but
there is also a short-cut: The “C” key takes you
there directly.

(However, it is also possible to simply press the
“C” key for a “long time“, (ca. 1 second), which
causes an immediate acknowledgment, see
below.)
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Acknowledge

ℹ All acknowledgeable LEDs will be acknowledged.

Sys.Ack LED

1. 2.

Use the Softkeys “▲” (Up) or “▼” (Down) to
select those categories of objects that you want
to acknowledge (reset):

• »Sys . Ack BO LED Scd Trips«: Reset the
binary output relays, LEDs, SCADA and the
TripCommand

• »Sys . Ack LED«: Reset all
(acknowledgeable) LEDs

• »Sys . Ack BO«: Reset all
(acknowledgeable) binary output relays

• »Qxx . Ack TripCmd«: Acknowledge (reset)
a previously given trip command (here:
trip issued to switchgear “Qxx”).

• »SSV . Ack System LED «: Acknowledge
(reset) the System-LED if it is reporting an
error by flashing red/green. (You can look
up error messages in the Troubleshooting
Guide.)

Then press the “Key” Softkey to select the
acknowledgment of your choice.
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Enter Password

Prot-Lv1
* * * *

1 2 3 4

Similar to the modification of a setting (see ╚═▷
“3.7 Parameter Changes – “OK” key”) you are
asked for the password (this time, however,
level “Prot-Lv1” is sufficient).

Whether there are different passwords for the
various access levels, or only one, or even
none, depends on the security policy of your
company. See the Technical Manual for details.

41HighPROTECHPT-3.7-EN-QSG

3 Quick Start – Operation via Panel
3.8 “C” key – Acknowledge (Reset) Latched Signals, Output Relays, Trip Commands



HP
T_

ZA
K

execute?

Info

yesno

?

After the correct password has been entered
(as you might remember, this input always
ends with pressing the »OK« key) there is a
final confirmation dialog.

After pressing the “yes” Softkey the selected
objects are acknowledged (reset).

“One Button Acknowledge”

As of Release 3.4, there is a very short and convenient method for acknowledging a pre-
defined choice of objects. This is available with a “long keypress“ (for ca. 1 second) of
the »C« key.

The set of objects to be acknowledged must be activated during commissioning, by
setting the parameter [Device Para / Acknowledge] »Ack via »C« key« to an appropriate
value. (The available choices are essentially the same as mentioned above.)

Whenever the LEDs are acknowledged an LED test is also executed: All LEDs flash in red
color for a second, then flash in green color for a second.
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3.9 “CTRL” key – Control Switchgear Devices
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IL1
IL2

0.000 A

Mode SG

Local

IL3
QA1

0.000 A
0.000 A

By pressing the »CTRL« key you enter a screen
showing the single line, and you have direct
access to related control functions.

Remark: The switchgear name »QA1« is only an
example; the available set of switchgear
devices and their designations are dependent
on your particular application.

A switching operation can be executed if the
switching authority (which is displayed in the
top right corner) is set to either “Local” or
“Local and Remote”.

Remark: Note that both this single line screen
as well as the two Softkeys “General Settings”
and “SG” are also accessible via the main
menu:

• The menu path [Control / Control Page]
gives access to this single line page.

• The menu path [Control / General
Settings] accesses the same menu branch
as the Softkey “Mode”.

• The menu path [Control / SG] accesses the
same menu branch as the Softkey “SG”.
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General Settings

ℹ Switching Authority

Switching Authority
Local

As an example, we want to execute a switching
operation now. Therefore we check the
switching authority first and enter the menu
branch [Control / General Settings] (e.g. by
pressing the Softkey “Mode”).

Within this menu branch, you can do several
switchgear-related settings, in particular
(re-)define the switching authority.

(Proceed as explained in ╚═▷ “3.7 Parameter
Changes – “OK” key”.)

For the »Switching Authority« setting the
following options are available:

• “None”: No (local or remote) control
function. (This setting does not affect a
protection trip.)

• “Local”: Control only via the buttons at the
panel (HMI).

• “Remote”: Control only via SCADA, digital
inputs or internal signals.

• “Local and Remote”: Control via HMI
buttons, SCADA, digital inputs, or internal
signals.
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SG
QA1

When the single-line is being displayed, the
Softkey “SG” takes you to a screen that lists all
connected switchgear devices.

(For Quick_Start_Guide_HPT devices of
type »MC…«, up to 6 switchgear devices are
supported. A device of type »MR…« can control
one switchgear device.)

After selecting a switchgear device, the Softkey
“ ▶” (Enter) takes you to the menu that is
dedicated to the selected switchgear device.
There you can make various settings, e.g.
control times, position indicators, external
ON/OFF commands, interlockings.
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IL1
IL2

0.000 A

CLOSE

Local

IL3
QA1

0.000 A
0.000 A

When the single-line is being displayed, the
Softkey “ ▶” (Enter) takes you to an enhanced
single line (after you have entered the
password for access level “Control-Lv1”). The
switchgear device is highlighted by small
markers (and in case of several implemented
switchgear devices, the Softkey “Select” is
visible, which allows you to select another one).

If the switching authority permits local
switching there are Softkeys “OPEN” and
“CLOSE” which allow for executing a switching
operation. (Note that usually, i. e. with correct
position status indication from the switchgear
device, only one of these two Softkeys is
visible: If, for instance, a particular switchgear
device is already open, only the “CLOSE” is
visible.)
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QA1.CLOSE

Confirmation

yesno

? Are you sure?

After pressing the “CLOSE” Softkey you get a
confirmation dialog.
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IL1
IL2

0.000 A

Mode SG

Local

IL3
QA1

0.000 A
0.000 A

The new position of the switchgear device is
shown on the display (as soon as it has been
reached according to the feedback of the
position indication, or after the configured
switching time has elapsed).

Moreover, the functionality of the Softkeys
changes so that the new permitted switching
operations are available.
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3.10 Assisting Tokens
Asterisk (Star)

LED

ℹ Assignment

Assignment 1
I[1] . active

⁕
⁕

Latched inactive
Ack signal - . -
LED active color red
LED inactive color -
Assignment 1 I[1] . active
Inverting 1 inactive
Assignment 2 - . -
Inverting 2 inactive
Assignment 3 - . -
Inverting 3 inactive
Assignment 4 - . -
Inverting 4 inactive
Assignment 5 - . -
Inverting 5 inactive

Name Value

Device Para/LEDs/LEDs group A/LED 1]

⁕
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The asterisk (star) has already been
mentioned in ╚═▷ “3.7 Parameter Changes –
“OK” key”.

This character “*” next to the parameter
indicates that there are temporary changes for
it (which are not yet effective).

On the device display, there is another asterisk
next to the heading line that indicates
parameter changes (within this menu branch)
that have not yet been activated by the device.

In Smart view, there is also a bold red “*” token
next to a parameter and all super-ordinated
menu levels. This indicates that parameter
changes exist that have not yet been stored in
a parameter file.
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Inconsistency Token (Question Mark)

LED

ℹ Assignment

Assignment 1
I[1] . active

⁕
?

Latched inactive
Ack signal - . -
LED active color red
LED inactive color -
Assignment 1 I[1] . active
Inverting 1 inactive
Assignment 2 - . -
Inverting 2 inactive
Assignment 3 - . -
Inverting 3 inactive
Assignment 4 - . -
Inverting 4 inactive
Assignment 5 - . -
Inverting 5 inactive

Name Value

Device Para/LEDs/LEDs group A/LED 1]
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The question mark token, either in the
heading of the display or as a bold red sign
within the Smart view dialog, indicates that a
validity or consistency problem has been
detected.

If Smart view is used for saving the settings as
a file then an additional warning dialog is
shown in case of inconsistent settings.

Moreover, the protection device refuses to
accept and activate the setting values.

An example for such a consistency problem can
be as follows: It is possible to set one of the
LEDs (for example, for a device with 14 LEDs,
the first LED in Group A) such that it is lit if a
particular protection function (I[1], for example)
is active. This is achieved by the following
setting:

[Device Para / LEDs / LEDs group A / LED
1] »Assignment 1« = “I[1] . active”.

In principle, there is nothing wrong with this
setting; it is the same setting that is also shown
above, as an example for the asterisk token.
But if it happens that the assigned protection
function is intentionally disabled (setting
[Device planning] »Mode« = “-”) then this is an
obvious consistency problem, and the LED
assignment is not accepted.
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Unused Setting Token

LED

ℹ Acknowledgement signal for the LED. If latching is set to active the LED can only be acknowledged if those signals that initiated the setting are no longer present.

Ack signal
-.-

Latched inactive
Ack signal - . -
LED active color red
LED inactive color -
Assignment 1 I[1] . active
Inverting 1 inactive
Assignment 2 - . -
Inverting 2 inactive
Assignment 3 - . -
Inverting 3 inactive
Assignment 4 - . -
Inverting 4 inactive
Assignment 5 - . -
Inverting 5 inactive

Name Value

Device Para/LEDs/LEDs group A/LED 1]

HP
T_

ZB
E

The circled dash “⊝” token indicates a
parameter that is currently not used or not
relevant.

In the example shown left, the LED is set to be
non-latching: »Latched« = “inactive”. Therefore
it does not make sense to have a setting for the
acknowledgment (reset) of this LED, so that the
parameter »Ack signal« is marked as irrelevant.
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Info Token

LED

ℹ The LED lights up in this color if the state of the OR-assignment of the signals is true.

LED active color
green

⁕
⁕

Help

Edit Value

Value Details

green
LED active color

Range of Values: Select a value from drop down

Access Level: Supervisor-Lv3

The LED lights up in this color if the 
state of the OR-assignment of the 
signals is true.

OK Cancel

Previous

Next
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The information token “ℹ” has already been
mentioned in ╚═▷ “3.7 Parameter Changes –
“OK” key”. It appears as part of a setting dialog
(on the device display in a dedicated line of
text, directly above the Softkey assignments, or
as a text frame within a Smart view setting
dialog window). It indicates the detailed
description of the parameter in question.
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3.11 Single-Line Diagrams
The single-line diagram is displayed after the »CTRL« has been pressed, see ╚═▷ “3.9
“CTRL” key – Control Switchgear Devices”. It can be replaced by another one, so that you
are able to adapt it to your application. The following is important to know in this context:

When Smart view saves the current configuration to a “*.HptPara”-file the currently
active single-line diagram is always included. Vice versa, if you load an HptPara file and
transfer it to the protection device the single line diagram contained therein gets
displayed.

But it is important to note that the other way round is not possible: There is no way to
retrieve the currently active single-line diagram (in editable form) from the protection
device, nor is it possible to export it from the HptPara file. As a consequence, it is
strongly recommended to archive all the files that you have come across, not only the
original file from which you started, but also all files that you created as individually
modified single-line diagrams. There is a dedicated “*.HptPage” file format that keeps a
single-line diagram – the so-called “page” – for later re-use.

Remark: The default single-line that the protection device displays after a factory reset
can be found as an HptPage file on the product CD that has been part of the delivery.
Alternatively, it can be downloaded from the web-address that is printed as a QR-code on
a sticker fastened on the device. In most cases you can use it as a template and adapt it
to your individual needs.

The software to be used for editing an HptPage file is named Page Editor. It is a stand-
alone application which is installed along with the Smart view installation. It is possible to
launch it the usual way, (for example) via the Windows Start button. But if you have
Smart view already running it is probably more convenient to use the menu item [Tools →
Page Editor].

Please refer to the Page Editor Manual for a description of what can be done within the
Page Editor. Although this manual is quite short these topics are out of scope of this
“Quick Start” description. The Page Editor Manual can be simply opened by calling the
Page Editor menu item [Help → Help] (or pressing the »F1« key).

After you have saved your own HptPage file you transfer it to the protection device as
follows:

⚙

1. ▷ In Smart view, open the menu item [Device planning].
2. ▷ A double-click on the entry »Ctrl . Single Line«, “①” in the diagram below, opens the

editing dialog.
3. ▷ Click on the button »Single-line Diagram...« (“②” in the diagram below).

▶ This opens a file-select dialog.
4. ▷ Select your HptPage file.

▶ The editing dialog displays the selected file (filename without “HptPage” extension, plus
preview. If you have successfully passed the “Compatibility Check” of the Page Editor
your new single-line should be o.k. so that the field »Single-line Error Messages« is
blank.

5. ▷ Click »Apply« to close the editing dialog (“③” in the diagram below).
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▶ The parameter »Ctrl . Single Line« is now marked as “modified” (see the list of token in
╚═▷ “3.10 Assisting Tokens”).

6. ▷ Just as with any parameter change, the final step is to transfer the modifcations to the
protection device (keys »F7« or »Ctrl«+»F7«, or menu items [Device → Transfer ALL
Parameters into the Device], [Device → Transfer only modified Parameters into the
Device], see ╚═▷ “2.2 Operation via Smart view”).

Ctrl . Single Line BusbarFeeder
Module . name Value

Device planning

Single-line Diagram

Single-line Name:

Single-line Error Messages:

Apply Cancel Help

Single-line Diagram...BusbarFeeder

QA1 Controlled Make Break SG
Name TypeSG #

SG 1

Switchgear Properties:

IL1
IL2

0 A
(local_remote)

IL3
QA1

0 A
0 A!

Preview

HP
T_

ZB
G

1

2

3
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4 Good to Know for Commissioning
Change Device Language

At any time you can change the language that the protection device uses (on its panel).
This language setting is independent of the language that Smart view uses.

⚙

1. ▷ Enter the menu item [Device Para / HMI].
2. ▷ Modify the parameter »Menu language«. Available values are: English, German, Russian,

Polish, French, Portuguese, Spanish, Romanian.
▶ After entering the appropriate password (access level “Supervisor-Lv3”) and accepting

the confirmation dialog the language changes according to the new setting.

Within Smart view, the language is altered via the menu item [Settings → Language...].
This becomes active only after a restart of Smart view.

Return to the Main Menu

At the panel, you can always press the Softkey “◀” (Left) repeatedly to get to the main
menu.

Validity / Consistency Check

Any parameter change automatically starts a check for logical dependencies (validity and
consistency check). If the device detects a problem the settings are marked by a question
mark “?”; in this case the settings cannot be saved and activated.

Check Internal Status

Keep in mind that the menu path [Operation / Status Display], together with all its sub-
menu items, gives an immediate overview of all available statuses and signals (for all
active modules).

So, whenever the Quick_Start_Guide_HPT protection device behaves in an unexpected
manner, this is generally the first starting point for checking whether the status of every
signal is as expected.

Reset

Keep in mind that there is a difference between “acknowledging” a latched signal
(described here), and resetting counters and states.

• The menu path [Operation / Acknowledge] (by default also accessible via the “C”
key) allows to “acknowledge” certain latched signals (LEDs, output relays, SCADA,
TripCommand).

• The menu path [Operation / Reset] collects reset commands for all resettable
counters and values.

So, if you are looking for a way to reset e. g. the Lockout of a Breaker Failure, you
should enter this menu branch (for this particular example, the appropriate reset
command is: [Operation / Reset] »CBF . Res Lockout«).
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Passwords Forgotten

NOTICE!

This section is only about the so-called “access-level passwords”, that are required for
any changes to the device settings.

There are also “connection passwords” for establishing a Smart view connection; but
since these are blank (i. e. disbled) by default we do not deal with them in this beginners'
document. Please read the “Security” chapter in the Technical Manual for detailed
information about passwords.

If the passwords have been lost the protection device can be set to use the default
password “1234”:

⚙

1. ▷ Press the »C« key during a cold restart.
▶ A Reset dialog appears.

2. ▷ From this Reset dialog, select »Reset all passwords«.
▶ There is a confirmation dialog, asking »Reset all passwords?«

3. ▷ Confirm with »Yes«.
▶ The device starts using the standard password »1234«.

NOTICE!

For technical reasons, this Reset dialog is available only in English language
(independent of the regional language being used later, after the device has started).

Note furthermore that the dialog might not appear at all because it has been
intentionally disabled, or the option to reset all passwords has been disabled. (See the
“Security Settings” chapter in the Technical Manual for details.)

In general, it is not advisable to keep the standard password »1234« permanently,
because it apparently does not offer any serious safety. While setting a new password (via
[Device Para / Security] »Password«), keep in mind that every access-level password is
always composed of only the digits 1, 2, 3, 4.

Basic Commissioning Steps

Make sure that all voltages are switched off and all equipment is “dead”! Take care of all
applicable national and international installation and safety regulations for working at
electrical power installations, and make sure that you have also read and understood the
“Commissioning” chapter in the Technical Manual.

Make the essential wiring connections, especially CTs and/or VTs, analog and digital inputs
and relay outputs, and protective and functional grounding (earth). (Protective grounding/
earth to be connected at the housing, functional grounding/earth at terminal number 1
(labeled “FE”) of the auxiliary power supply (slot 1).

The set of terminals that is available for each slot is shown on an adhesive label that is
glued to the housing of the protection device. In case this is no longer visible (because
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the protection device has been built into a cabinet in a way such that the label is covered)
you can consult the separately available “Wiring Diagrams” document.

Before powering on the auxiliary power supply (with the system still being “dead”!), it
must be guaranteed that the grounding has been done correctly. Then make all the
required settings, in particular the Field Parameters (connected CTs and VTs and all the
other connected external equipment), and the Device Parameters (settings for analog and
digital inputs and outputs relays, LEDs, etc). Then make all the protection settings as
required for your application, and do not forget about the control (switchgear) settings.

Perform all required tests carefully, in particular the signal and control circuits, check the
correct rating and burden of the CTs, the function of the transformer fuses and the
required communication lines and settings.

The protection function tests must include the following:

• Check whether activation/tripping is saved in the event recorder, and whether
tripping is saved in the fault and disturbance recorder.

• Check whether all signals and messages are correctly generated.

• Check whether all general and temporary blockings (parameterized and/or via digital
input) work properly.

Note that all immediate types of acknowledgments (resets) include an LED test, i. e. all
LEDs flash in red color for a second, then flash in green color for a second. Information
about acknowledgments can be found in the “Acknowledgments” chapter of the Technical
Manual, for the basic principles see ╚═▷ “3.8 “C” key – Acknowledge (Reset) Latched
Signals, Output Relays, Trip Commands”.

Prior to the initial operation of the protection device all tripping times and values shown
in the adjustment list have to be confirmed by a secondary test.

Field Parameters

The menu branch [Field Para] collects settings that are related to external (field /
application) properties rather than to the operation of the protection device itself. In this
category there are, for example, the properties of the CT and VT that are connected to
the protection device.

The following is important to know with respect to the VT settings:

• [Field Para / VT] »VT sec«: This is the nominal voltage of the Voltage Transformers at
the secondary side. It is always defined as the “line-to-line” voltage.

• [Field Para / VT] »VT con«: This parameter has to be set (“Phase to Phase” or “Phase
to Ground”, depending on the application) in order to ensure the correct assignment
of the voltage measurement channels in the device.
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Overcurrent Protection (Modules I[n])

There are several instances (stages) of the Overcurrent Protection module, but all of
these are identically structured. This means it is the responsibility of the commissioning
engineer to set thresholds and timer values such that – for example – the second
instance »I[2]« works like a second overcurrent stage »I>>«.

Moreover, it can be configured for each instance separately whether it shall work in
directional or non-directional mode. This is done with the parameter [Device
planning] »I[n] . Mode«, which can be set to “non directional”, “forward” or “reverse”.

It is, however, interesting to know that the direction determination is not implemented
as a part of the I[n] modules. It is part of the module Prot (“Module General Protection”),
which acts in this case as a “helping hand” doing the direction determination for all I[n]
modules. This fact does not have an impact on configuration work, but it is good to know
that some results of directional decisions are signaled by Prot, for example signals such
as »I dir fwd«, »I dir rev«, »IG calc dir fwd«, … (All these state signals can be found in
menu branch [Operation / Status Display x / Prot].)

Sensitive Ground (Earth) Current

The Sensitive Ground Current must be activated by the following setting: [Protection
Para / Set x / I-Prot / IG[n]] »IG Source« = “sensitive measurement”

Since the default setting of this parameter is “calculated” this must be adapted,
otherwise the threshold setting »IGs>« is not available.

Voltage Protection (Modules V[n])

There are several instances (stages) of the Voltage Protection module, but all of these
are generic and identically structured; in particular, these are not “specialized” to either
overvoltage or undervoltage protection.

You can specify for each instance (independently) during commissioning whether it shall
work as overvoltage or undervoltage protection. This is done with the parameter [Device
planning] »V[n] . Mode«, which can be set to “V>” (overvoltage) or “V<” (undervoltage).

All other settings that are part of this instance are then adapted accordingly. For
example, the threshold value »V[n] . V>« is visible only if the instance is working in
overvoltage mode. If it is in undervoltage mode then »V[n] . V>« is automatically
disabled, and »V[n] . V<« gets visible instead.

Therefore a Quick_Start_Guide_HPT protection device does not use a specific name like
“V<”, “V<<” or “V>”, “V>>” for the voltage protection; it uses the generic module
names V[1], V[2], etc.

Usually the parameter [Protection Para / Set x / V-Prot / V[n]] »Measuring Mode« should
be set according to the Field Parameter setting »VT con«. However, the following can be
good to know:

If »VT con« = “Phase to Phase” then »Measuring Mode« is fixed to “Phase to Phase”.
(Even if »Measuring Mode« is accidentally set differently this setting is silently ignored.)

The nominal voltage Vn is defined as follows:

Vn = VT sec
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If »VT con« = “Phase to Ground” then the user has the choice to set »Measuring
Mode« either to “Phase to Ground” or “Phase to Phase”.

In case of »Measuring Mode« = “Phase to Ground”, the nominal voltage Vn is defined as
follows:

Vn = VT sec / 3

In case of »Measuring Mode« = “Phase to Phase”, the nominal voltage Vn is defined as
follows:

Vn = VT sec

Residual Voltage Protection (Modules VG[n])

The residual voltage can be measured via auxiliary windings da-dn (da [e]-dn [n]) in a
broken delta connection.

The calculation of the residual voltage is only possible if phase to neutral voltages are
applied to the measuring inputs of the protection device.

Direction Determination

Direction determination is available only for protection devices that are able to measure
phase currents and voltages.

If direction determination is available then it is a feature of the module Prot (“Module
General Protection”, see ╚═▷ “Overcurrent Protection (Modules I[n])”).

It is important to know that the general convention for all Quick_Start_Guide_HPT
protection devices is that “forward” direction always points towards the main object to
be protected. For example, this means for a generator protection device that a “forward”
fault is not in direction towards the power system, it is rather in direction towards the
generator.

Adaptive Parameter Sets

By means of Adaptive Parameter Sets you can modify dynamically setting values within a
protection module.

NOTICE!

Adaptive Parameter Sets are available only for a few protection modules (essentially only
the overcurrent protection modules).

From the practical point of view, there is one essential difference to the ordinary
parameters sets: Switching to another parameter set affects all protection functions at
once. This can increase your commissioning and testing efforts considerably if you “only”
want to modify the behavior of one particular protection function.

Contrast to this, Adaptive Parameter Sets are “local”, i. e. they are effective only within
the protection function where they had been activated. (See below how to do this.)

You can assign a digital signal to any of the parameters [Protection Para / Global Prot
Para / I-Prot / “module”] »AdaptSet 1«, …, »AdaptSet 4«. (“module” means the name of a
protection module that features Adaptive Parameter Sets, for example: [I[1]]).
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These four assignment parameters are always “Global Parameters” (i. e. within the menu
branch [Protection Para / Global Prot Para]). For example, let us make the following
assignment: »AdaptSet 1« = “V[1] . Alarm”, see the upper dialog window ① in the
diagram below.

With this assignment, the Smart view dialog window for the “Setting Group Parameters”,
for example the menu branch [Protection Para / Set 1 / I-Prot / I[1]], is getting enhanced
by an additional column ②, as shown in the bottom dialog window in the diagram below.

ExBlo1 - . -
ExBlo2 - . -
ExBlo TripCmd - . -
Ex rev Interl - . -
AdaptSet 1 V[1] - 27, 59 . Alarm
AdaptSet 2 - . -
AdaptSet 3 - . -
AdaptSet 4 - . -

Name Value

Protection Para/Global Prot Para/I-Prot/I[1] ...

Function active
ExBlo Fc inactive
Ex rev Interl Fc inactive
Blo TripCmd inactive

Measuring method Fundamental
I> 1
Char DEFT

Name DefaultSet

Protection Para/Set 1/I-Prot - 50, 51/I[1] - 50, 51

V[1] - 27, 59 . Alarm Unit

ExBlo TripCmd Fc inactive

1
DEFT

In

t 1 1 s HP
T_

ZB
K

1

2

Fig. 3: An assignment to an Adaptive Set parameter adds alternative values to Setting Group
parameters.

By this Adaptive Set assignment, most Setting Group Parameters receive an additional,
alternative value. At first this new value is identical to the DefaultSet value, but it can be
edited the same way. (Double-click it and modify it according to your needs.)

The idea is simple: The protection parameters use the alternative »AdaptSet 1« value as
soon as the assigned signal “V[1] . Alarm” becomes true.

Since there are four normal setting groups, and each of these can have up to four
Adaptive Sets plus the DefaultSet, this means that parameters supporting Adaptive Sets
can have up to 20 different setting values.

Application Examples for Adaptive Parameter Sets

• AR: auto-reclosing with 2 shots

◦ 1st shot DEFT characteristic, normal tripping stage

◦ 2nd shot INV characteristic, sensitive tripping stage
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• CLPU: cold load pickup

◦ Motor start, de-sensibilize current protection

• SOTF: switch on to fault

◦ De-sensibilize current protection

• ANSI 51C: voltage controlled over current

◦ Generator, motor, de-sensibilize current protection

Digital Inputs

It is not possible to assign a function to a Digital Input! Instead, it is the other way round:
You assign the status (signal) of a Digital Input to the input parameter of a particular
module.

If, for instance, it is required to block the Prot[1] overcurrent protection module as soon
as there is a signal at the Digital Input “DI1” of the power supply card (terminal number 6
of slot X1) then the following setting can be used:

[Protection Para / Global Prot Para / I-Prot / I[1]] »ExBlo1« = “DI Slot X1 . DI 1”

Binary Outputs

If binary outputs are configured with the setting »Latched« = “active”, they will always
keep (return into) their position, even if there has been an interruption of the power
supply.

This means that resetting a binary output that has latched a signal always requires an
explicit acknowledgment activity (see ╚═▷ “3.8 “C” key – Acknowledge (Reset) Latched
Signals, Output Relays, Trip Commands” and – for details – Chapter “Acknowledgment” in
the Technical Manual).

Load Reference Arrow System

• It is common practice to either use the “Load Reference Arrow System” for loads
(consumed energy) and the “Generator Reference System” for generators
(generated energy).

• All Quick_Start_Guide_HPT protection devices (except generator protection devices)
use exclusively the “Load Reference Arrow System”. Generator protection
devices are working based on the “Generator Reference System”.

• This applies to directions and phase angles. The phase angle is defined as the angle
between the current phasor and the voltage phasor.

• Current and voltage arrows are to be counted positive in the direction of the arrow.

Trip Commands

The protection device monitors the object to be protected, and if any serious fault should
occur, it is expected to issue a trip command.

Most protection functions feature an »Alarm«, a »Trip« and a »TripCmd«.

• An »Alarm« signal is issued by a protection function that detects a particular type of
fault. If the protection function distinguishes between several fault types (e. g.
phase-specific faults) then a respective »Alarm« signal exists for each.
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Every »Alarm« signal gets routed (internally) to the general protection
module »Prot«, which in turn issues a signal »Prot . Alarm«.

In other words, the signal »Prot . Alarm« is a collective signal; if it has the state
“True” this represents the message “some protection function has detected a fault”.
(The same is true of the respective phase-selective signals.)

• Moreover, every »Alarm« triggers a »Trip« (in general: after a dedicated timer stage
has elapsed).

The »Trip« triggers a general trip signal »Prot . Trip« (just the same way as the »Prot .
Alarm« is triggered). So, if »Prot . Trip« = “True” this represents the message “some
protection function has detected a fault that persists for a time longer than
tolerable”. (And again, the same for the phase-selective signals.)

• Finally, the protection function issues not only the »Alarm«, but also the trip
command (»TripCmd«), but only under the condition that trip commands are not
blocked.

(There are various methods to intentionally block trip commands. For example, a
general blocking of the trip commands of all protection functions can be achieved by
setting [Protection Para / Global Prot Para / Prot] »Blo TripCmd« = “active”. See the
full Technical Manual for details.)

• It is important to know that the trip command of a protection function does not
necessarily open a circuit breaker! Every connected switchgear is represented by a
module. This module has a trip command of its own, which can send an open
command to the assigned output relay, to open the circuit breaker.

Therefore one additional setting is essential to establish the relationship between
the protection function's trip command and the switchgear's trip command: There is
a so-called “Trip Manager” (which is simply synonymous for the switchgear-specific
menu paths [Control / SG / SG[x] / Trip Manager]); besides some breaker-specific
settings (switching times, latching, etc.) you can find there a lot of setting
parameters named »Off Cmdn«, and to each of these you can assign one protection
function's trip command. Then, if any of the assigned protection trip commands is
issued the switchgear's trip command is issued, so that after all, the respective
circuit breaker opens.
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Let us take a simple, non-directional phase overcurrent protection as an example (see
diagram above), e. g. the module I[1].

This module monitors the phase current flow according to criteria that had been specified
by setting various parameter values during commissioning. If a fault occurs (according to
these defined criteria) the I[1] instance issues various output signals, especially a trip
signal (»Trip«) and, after some trip delay timer has elapsed, a trip command (»TripCmd«).
(Of course, we assume for now that there is no active blocking, neither for the I[1]
instance nor for its trip command.)
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The »I[1] . Trip« signal is always reported to a protection master module, named Prot. This
is very important to keep in mind, because if the Prot module should be blocked – which
can be useful for testing purposes – then absolutely no protection function is able to issue
a trip command, this master protection module will block them all!

Moreover, the »I[1] . TripCmd« signal can become effective only if it has been assigned to
a switchgear device. Usually one of the switchgear devices is a circuit breaker, which has
to be opened. The set of switchgear devices and their designations is defined using the
Page Editor, see ╚═▷ “3.11 Single-Line Diagrams”. The properties of the switchgear
device (switching times, latching of the respective output relay, etc.) must be set within
the respective switchgear module, for example within the menu path [Control / SG /
SG[1] / General Settings].

Then, in the menu path [Control / SG / SG[1] / Trip Manager], there are many setting
parameters named »Off Cmd1«, »Off Cmd2«, …, all with identical functionality: The trip
command from the protection module, must be assigned to one of these, for instance:

»SG[1] . Off Cmd1« = »I[1] . TripCmd«.

When »SG[1] . Off Cmd1« becomes active, the switchgear module SG[1] issues its own
trip command »SG[1] . TripCmd«.

This trip command must be assigned to an output relay, that actually does the switching
operation. So, let us assume that slot 2 of the protection device is fitted with a binary
output module, so that we can use output relay number 1 for this purpose. Then the
correct assignment to be made during commissioning is: [Device Para / Binary Outputs /
BO Slot X2 / BO 1] Assignment 1« = “SG[1] . TripCmd”

Documents

All relevant documents describing the protection device are contained on the DVD that is
delivered with the device. Nevertheless it is recommended to check from time to time
whether updated or corrected versions have been made available online.

There are two ways of accessing the documents via internet:

• Visit the company website and search for the documents you are interested in. (The
ID of every document is printed on its cover page.)

• There is, however, a more convenient way: Every device has a QR code printed on it.
Scan this code, and you are taken to an online directory that contains all relevant
documents in the most recent version.
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Notice: One of the documents that is included
on the DVD and available online is named
“Front_Foil_Label /
Quick_Start_Guide_HPT_Inserts”. This is is a
template file that allows to label the LEDs in a
proper way.

You can print this out on a transparent foil and
fasten it on the front plate of the device.
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5 Configuration via Smart view
It is recommended to use the Smart view operation software for all setting activities that
are beyond changing only a few values. See the basic description (╚═▷ “2.2 Operation via
Smart view”) about how to establish a connection. A detailed description can be found in
the Smart view manual.

It is strongly recommended to archive all the “*.HptPara” configuration files that you
have come across, both in the state before your modifications and the modified one.

The »[File]« menu of Smart view offers the usual menu items for handling HptPara files
(»Create New Parameter File«, »Open Existing Parameter File«, »Save«,…).

CAUTION!

However, clicking [Save] does not activate changed values (even though the asterisk
tokens disappear). The [Save] menu (and button) does nothing more than saving your
changes to a *.HptPara file. Remember to always also transfer the parameters to the
connected device if you want to activate your changes.
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5.1 Configuration File
An HptPara file is always related to a device model (see also the “Notice” in ╚═▷ “2.2
Operation via Smart view”). Therefore you have two alternative principles for the creation
of a new configuration file:

• Creating a *.HptPara offline, i. e. without being connected to a protection device. In
this case Smart view opens selection dialogs, asking you to specify the exact device
and typecode for which the configuration shall be made, see diagram below. (The
“typecode” defines the particular device variant, including housing and
communication options.)

In the typecode dialog, it is possible to double-click every specification line (or
highlight it and click the »Edit« button) and adapt the entry to your particular device.
Alternatively, you can also click the “pencil” button and directly type in the letters
and digits of your device's typecode.

You can find the typecode printed as “CAT No.” on the adhesive label that is glued to
the housing of the protection device. Moreover, as of Release 3.4, you can also
check the parameter value of [Device Para / Version] »CAT No.«.

And finally, you can use the Smart view menu »[File → Properties]« to open a window
that displays various information, including the typecode.

• Creating a *.HptPara while being connected to a particular device. In this case
Smart view defines all settings for this particular device, and immediately after
having retrieved the data from the device Smart view asks you whether you want to
save them into a new HptPara file. (Of course it is possible to re-use the HptPara file
later for another protection device, provided the variant and firmware version
(release) are identical.)
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Create a new Parameter File for Device Family

Select the Device Type from the list below:
HighPROTEC Device Family

MCA4, Version 3.4.a
MCA4, Version 3.0.b

MCDGV4, Version 3.0.b
MCDGV4, Version 3.4.b

MCA4, Version 3.4.a

Create New Parameter File

Device Type: MCA4, Version 3.4.a

Device Configuration:

Hardware Variant 1
Name Value

Device Model Filename: C:\ProgramData\Woodward SEG\HighPROTEC\DeviceModels\MRA4_V3.4.a.DeCon

Resulting Device Typecode: MCA4-2D0AAA

Apply

Edit

Cancel

Help

Hardware Variant 2
Housing
Communication
Printed Circuit Board

16 digital inputs | 13 binary output relays
Phase Current 5A/1A, Ground Current 5A/1A
Flush mounting
Without
Standard

Fig. 4: For offline creation of a configuration file, you are first asked for the device name and
version. After this, specify the particular device variant.

Modify Device Configuration (Typecode)

If one tries to transfer an HptPara file to a connected device which differs in its typecode
(for example: “MCDGV4‑2A0ATA” HptPara ⇒ MCDGV4‑2A0AAA) then Smart view refuses
to do so with a “Type mismatch!” error message telling you that the typecodes are not
the same.

In this case you can convert the settings to the typecode of the connected device. (This
does not work for different Quick_Start_Guide_HPT devices!)

Select the Smart view menu »[Edit → Modify Device Configuration (Typecode)]« to open
the device variant dialog, which is essentially the same as described above (╚═▷ Fig. 4).
Here you can specify the target typecode (which should be the typecode of the connected
device, of course).
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Shortcuts Device Data

Smart view

Operation

Device planning

Device Para

1,0

Field Para

50/60

Protection Para
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MCDGV4
Operation
Device planning
Device Para
Field Para
Protection Para
Control
Logics
Service

Modify Device Configuration

Device Type: MCDGV4, Version 3.4.b

Device Configuration:

Hardware Variant 1
Name Value

Device Model Filename:

Resulting Device Typecode MCDGV4-2A0AAA

Apply

Edit

Cancel

Help

Hardware Variant 2
Housing
Communication
Printed Circuit Board

16 digital inputs | 11 binary output relays
Phase Current 5A/1A, Ground Current 5A/1A
Flush mounting
Without
Standard
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Modify Device Configuration

Device Type: MCDGV4, Version 3.4.b

Device Configuration:

Hardware Variant 1
Name Value

Device Model Filename:

Resulting Device Typecode MCDGV4-2A0ATA

Apply

Edit

Cancel

Help

Hardware Variant 2
Housing
Communication
Printed Circuit Board

16 digital inputs | 11 binary output relays
Phase Current 5A/1A, Ground Current 5A/1A
Flush mounting
RS 485, Ethernet: IEC 61850 Modbus TCP, RTU IEC 60870-5-103 DNP UDP, TCP, RTU
Standard

Modify Parameters...

Compare Parameter Sets...
Copy Parameter Sets...

Modify Device Configuration (Typecode)...

Edit

Fig. 5: Converting a configuration file from “MCDGV4‑2A0ATA” to “MCDGV4‑2A0AAA”.

Note that after pressing the »Apply« button, it takes Smart view some time to perform
various validity and consistency checks. For a quite simple conversion, as shown in the
example above, the checks should not find any problems, so that it is possible to transfer
the configuration to the connected device, as already described (see ╚═▷ “2.2 Operation
via Smart view”).

The more differences exist between the source and target typecodes, the more likely it is
that consistency problems are found, which are then marked by question mark “?”
tokens, as described in ╚═▷ “3.10 Assisting Tokens”. These must be corrected manually,
before the settings can be transferred to the device. Even without serious consistency
problems, it is strictly recommended to always have a look at the resulting settings: In
the example above, the conversion goes from a device with communication to a target
device without any communication features; of course, this is rather simple.

In the vice versa case, however, if the conversion goes from a device without
communication to a target device with any communication features, it is impossible to
expect sensible communication values from a non-communication source. So, after all,
you should never trust an automatic conversion! Always have a look yourself before you
go live with the settings.
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Upgrade Firmware Version

A comparable problem arises if one tries to transfer an HptPara file to a connected device
which differs in its firmware version: Smart view refuses the transfer with an “Invalid
Parameter file!” error message.

In this case you can convert the settings to the firmware version of the connected device.

NOTICE!

The conversion does not work for different Quick_Start_Guide_HPT devices, nor does it
work from a new firmware to an older version! In other words, it is only possible to
“upgrade” a device.

Select the Smart view menu »[File → Save As...]« to open the normal “Save As” dialog. As
you can see, the “file type” shown at the bottom of the dialog is not only “*.HptPara”,
but the version number is also part of it. Now you can expand the “file type” selection list,
it offers all versions for which a device model has been previously installed (see also the
Notice about device models in ╚═▷ “Setting up the Connection PC - Device”). Adapt the
file name according to your target device and click »Save«.

MCDGV4_V3_0_b.HptParaFile name:
File type:

CancelSave
HighPROTEC Parameter MCDGV4 3.4.b (*.HptPara)
HighPROTEC Parameter MCDGV4 3.0.b (*.HptPara)
HighPROTEC Parameter MCDGV4 3.4.b (*.HptPara)

Device connectedReady

Shortcuts Device Data

Smart view

Operation

Device planning

Device Para

1,0

Field Para

50/60

Protection Para

765

MCDGV4
Operation
Device planning
Device Para
Field Para
Protection Para
Control
Logics
Service

HP
T_

ZB
M

Create New Parameter File...
Open Existing Parameter File...
Close
Recent Parameter Files

Save
Save As...

Ctrl+N
Ctrl+O

Ctrl+S

▶

File

Fig. 6: Converting a configuration file for the MCDGV4 from version “3.0.b” to “3.4.b”.

There is a confirmation dialog, asking whether you want to convert between different
versions, and finally, there is a summary about successfully converted, added and
deleted settings.
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Number of successfully converted values: 9216

Detailed info about added and deleted parameter:

Name Value

Print... Close Help

Convert "MCDGV4" Parameter (from version "3.0.b" to version "3.4.b")

Number of added values with default settings: 0
Number of deleted values, which are no longer available: 0

Fig. 7: Conversion summary.

Just like with a typecode conversion (╚═▷ “Modify Device Configuration (Typecode)”),
Smart view performs various validity and consistency checks and reports any problems.

The bigger the difference is between the versions, the more settings will have to be
added (or deleted), and it becomes likely that consistency problems are found, which are
then marked by question mark “?” tokens, as described in ╚═▷ “3.10 Assisting Tokens”.
All settings problems must be corrected carefully, before they can be transferred to the
device. Since new firmware versions come with new features, the conversion can do
nothing about this but simply adding the respective new settings with only their default
values. These defaults usually set the new feature “inactive”, which might or might not
match your application needs. So, after all, you should never trust an automatic
conversion! Always have a look yourself before you go live with the settings.
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5.2 Configuration Steps

5.2.1 Display Language

Enter the menu [Device Para / HMI] and set the parameter »Menu language« to any of the
supported languages according to your preferences.

This defines the language that the protection device uses on its panel.

NOTICE!

This does not switch the language that Smart view uses for displaying the settings. This
has to be set via the Smart view menu »[Settings → Language]«. Note that changing this
requires a restart of Smart view.

5.2.2 Device Planning

Enter the menu [Device planning] and activate or disable all the modules and protection
functions that are required for your application.

In the »Device planning« dialog, double-click every required module and set it to “use”.
Modules that are not required should be set to “-”.

This defines the functional range of the protection device.
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Ctrl . Single Line BusbarFeeder
Module . name Value

Device planning

IH2 . Mode -
I[1] - 50, 51 . Mode -

Device connectedReady

Shortcuts Device Data

Smart view

Operation

Device planning

Device Para

1,0

Field Para

50/60

Protection Para

765

MCDGV4
Operation
Device planning
Device Para
Field Para
Protection Para
Control
Logics
Service

File Device Edit View Settings Tools Window Help

Fig. 8: Double click [Device planning] and select the required protection and supervision
modules.

5.2.3 Measurement Display

Enter the menu [Device Para / Measurem Display / General Settings] and set the
parameter »Scaling« to either “Per unit values”, “Primary values” or “Secondary values”.

This defines how the measured values shall be displayed.
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5.2.4 Digital Inputs

Enter the menu [Device Para / Digital Inputs] and all sub-menu items therein (depending
on your hardware, i. e. which slot are fitted with digital inputs), for example [Device Para /
Digital Inputs / DI Slot X1 / Group 1]. Set the parameter »Nom voltage« to either “24
VDC”, “48 VDC”, “60 VDC”, “110 VDC”, “230 VDC”, “110 VAC”, “230 VAC”.

This defines the nominal voltage of the binary input.

In the same way set and/or check the other settings, »Inverting x« and »Debouncing time
x«

This defines the whether the binary input shall be inverted, and which time interval shall
be used for the input signal to avoid misinterpretation due to bouncing effects.

5.2.5 Output Relays (Binary Outputs)

Enter the menu [Device Para / Binary Outputs] and all sub-menu items therein (depending
on your hardware, i. e. which slots are fitted with output relays), for example [Device
Para / Binary Outputs / BO Slot X2 / BO 1].

Set the parameters for the operating mode, hold and delay times, latching, the
acknowledgment signal (if »Latched« is set to “active”), and for up to 7 binary output
signals, you can assign a digital output signal to the output relay
(parameters »Assignment 1«, …, »Assignment 7«) and decide about »Inverting x« for this
signal.

This defines which signals shall be indicated by output relays. If any of the 7 assigned
signals becomes true, the output relay becomes either active (if »Inverting« =
“inactive”), or vice versa (if »Inverting« = “active”).

5.2.6 LED Assignment

Enter the menu [Device Para / LEDs].

Set the parameters for latching, the acknowledgment signal (if »Latched« is set to
“active”), the active and inactive LED color and flashing mode, and for up to 5 binary
output signals, you can assign the signal to the LED
(parameters »Assignment 1«, …, »Assignment 5«) and decide about »Inverting x« for this
signal.

This defines which signals shall be made visible by LEDs. If any of the 5 assigned signals
becomes true, the LED is lit in the active color, otherwise it is lit in the inactive color.
(Both colors may also be set to “-”, which means the LED is off.)

5.2.7 Field Parameters

Enter the menu [Field Para], including all available sub-menus, and set all parameters
that define the field (i. e. the “surrounding”) of the protection device.

In particular, take care of the following settings:
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• [Field Para / General Settings] »Phase Sequence« selects the phase sequence (“ABC”
or “ACB”).

• [Field Para / General Settings] »f« selects the nominal frequency (“50” or “60”).

• [Field Para / VT] »VT con« selects the type of phase voltages (“Phase to Phase”, i. e.
delta connection, or “Phase to Ground”, i. e. star connection).

• [Field Para / VT] »VT pri« sets the nominal primary voltage Vn. Note that this is
always the phase-to-phase voltage (independent of the connection type).

• [Field Para / VT] »VT sec« sets the nominal secondary voltage Vn. Note that this is
always the phase-to-phase voltage V LL (independent of the connection type).

Note that Synchrocheck is a protection module of its own; if you want to use it you have
to activate it in the project settings ([Device planning] »Sync . Mode« = “use”); more
information about the Synchrocheck: ╚═▷ “5.2.10 Synchrocheck Settings”.

• [Field Para / CT] »CT pri« sets the nominal current on the primary side of the current
transformers.

• [Field Para / CT] »CT sec« sets the nominal current on the secondary side of the
current transformers.

For protection devices with two CT inputs (e. g. generator or transformer protection
devices) the settings have to be made for all inputs, of course.

For protection devices with CT and VT inputs, the menu [Field Para / Direction] features
settings related to direction determination, for example:

• [Field Para / Direction] »Phase MTA« sets the maximum torque angle (angle between
phase current and reference voltage in case of a short circuit).

• [Field Para / Direction] »IG calc dir control«, or »IG meas dir control«: These options
are used as operating quantities for direction detection.

• [Field Para / Direction] »Ground MTA« sets the neutral point treatment (ground
maximum torque angle, i. e. angle between chosen operating quantity and chosen
reference quantity in case of a ground fault).

◦ isolated grid, sin(-90°): »Ground MTA« = 180°

◦ compensated grid, cos(180°): »Ground MTA« = 270°

◦ solidly earthed: »Ground MTA« = 170°

◦ impedance earthed: »Ground MTA« = 110°

5.2.8 Blocking Parameters

It is an important principle that every protection module can be separately blocked. There
are usually the following blocking parameters part of every protection module:

• »ExBlo1«, »ExBlo2«: These are setting parameters to which a binary signal can be
assigned. The complete protection module is blocked if any of the assigned signals
becomes true (“active”).

⇒ There is no LED indication of the blocking. The protection module does not issue a
trip, there is no fault recording, etc.
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• »ExBlo TripCmd«: This is a setting parameter to which a binary signal can be
assigned. The protection module remains active if the assigned signal becomes true,
only the trip command is blocked.

⇒ There is an LED indication of the blocking, the fault recording works o.k., etc. But
there is no trip command.

• »Blo TripCmd«: This parameter is simply set to “active” or “inactive”, no digital
signals are assigned. If it is set to “active” then the trip command is blocked, but the
protection module remains active.

⇒ There is an LED indication of the blocking, the fault recording works o.k., etc. But
there is no trip command.

However, all these blockings can be functional only if the blocking functionality has been
explicitly allowed for the particular protection module. This is done by the setting »ExBlo
Fc« = “active”. If it is set to “inactive” then all blockings are ignored for this protection
module, i. e. the module stays operational all the time.

5.2.9 Protection Parameters

Protection settings can be either “Global Parameters” (within the menu branch [Protection
Para / Global Prot Para]), or “Setting Group Parameters” (within the four menu branches
[Protection Para / Set 1], …, [Protection Para / Set 4]).

NOTICE!

By using Adaptive Parameter Sets you can react to special situations with great
flexibility, because Adaptive Parameter Sets do not affect all protection functions at once,
but only one particular protection function. For more information, see ╚═▷ “Adaptive
Parameter Sets”.

The Global Parameters are essentially the settings for blocking protection modules (see
also above). Note, however, that it is not sufficient to assign a signal to e. g. »ExBlo1«. It
is also necessary to enable the blocking feature (for every module that shall use it). This
enabling setting is not a Global Parameter, but a Setting Group Parameter.

The Setting Group Parameters actually specify the behavior of all protection modules.
Every Setting Group Parameter exists in every parameter set, i. e. four times. The
parameter [Protection Para / PSet-Switch] »PSet-Switch« defines which parameter set the
device uses. Since switching to another parameter set makes all protection function use
another set of setting values you can react very flexibly to different situations that your
application might assume.

The »PSet-Switch« parameter can be either set explicitly to any of the parameter sets
“PS1”, …, “PS4”, or it can be set to “PSS via Inp fct” (switching triggered by digital input
signals, that have been assigned to [Protection Para / PSet-Switch] »PS1: activated
by«, …, »PS4: activated by«), or it can be set to “PSS via Scada” (switching triggered by
SCADA).

The already mentioned parameter [Protection Para / Set x / I-Prot / I[1]] »ExBlo Fc« is one
example for a Setting Group Parameter: It enables blocking of the overcurrent protection
module I[1].

Since this parameter is part of the overcurrent protection module I[1], we often denote it
as »I[1] . ExBlo Fc«, instead of always writing down the full menu path. And the
functionality of this parameter is to enable blocking of I[1]. Only if this parameter (in the
currently active parameter set) has the value “active” and the digital signal assigned
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to »I[1] . ExBlo1« (or the one assigned to »I[1] . ExBlo2«) is “active” then the overcurrent
protection stage I[1] gets blocked.

5.2.10 Synchrocheck Settings

For proper operation of the Synchrocheck module, settings have to be made in three
different menu branches:

• In [Device planning], make sure that »Sync . Mode« is set to “use”.

• In [Protection Para / Global Prot Para / Intercon-Prot / Sync], there are several
settings to be checked. In particular, assign a close request signal to »Sync .
CBCloseInitiate«, for example the signal “QA1 . Sync ON request” (with “QA1” being
only an example, the switchgear designation can be defined using the Page Editor
application, see ╚═▷ “3.11 Single-Line Diagrams”).

• In [Protection Para / Set 1 / Intercon-Prot / Sync / Mode / Times], check the time-
related parameters, then select the synchronization mode:

◦ »Sync . SyncMode« = „System2System“ – synchro-check between two systems,
stand-alone, no breaker info needed, or

◦ »Sync . SyncMode« = „Generator2System“ – synchronizing a generator to a
system, breaker close initiate needed.

• In [Protection Para / Set 1 / Intercon-Prot / Sync / DeadLiveVLevels], check the
voltage thresholds that are used as synchronization criteria. In the same way, check
the settings in [Protection Para / Set 1 / Intercon-Prot / Sync / Conditions]. Finally, in
[Protection Para / Set 1 / Intercon-Prot / Sync / Override], specify whether overriding
shall be “active” or “inactive”.

• In [Control / SG / QA1 / Synchron Switchg], set »QA1 . Synchronism« to “Sync .
Ready to Close”, so that the switchgear “QA1” gets a “closing allowed” signal from
the Synchrocheck module.

5.2.11 Trip Manager and Switchgear Configuration 1

Enter the menu [Control / SG / Qxx / Trip Manager] for every switchgear device “Qxx” that
is available for your protection device. (Remark: The designations “Qxx” depend on the
settings that you have made in the single-line, see ╚═▷ “3.11 Single-Line Diagrams”.)

Set the parameters for latching, the acknowledgment signal (if »Latched« is set to
“active”) and all the other settings that are relevant for your application. In particular,
assign the trip commands of the required protection functions to any of the
parameters »Off Cmd1«, »Off Cmd2«, ...

This way you specify all the trip commands that shall lead to a trip of the circuit breaker
“Qxx”.

Enter the menu for the binary output (i. e. the output relay) that shall be used with the
circuit breaker “Qxx” and assign the trip command »Qxx . TripCmd« to the respective
output relay. This is depending on your hardware configuration, of course; the setting
might be, for example: [Device Para / Binary Outputs / BO Slot X2 /
BO 1] »Assignment 1« = “Qxx . TripCmd”

The trip command becomes active, in the sense that it triggers an output relay. This is
absolutely essential is any protection function shall open a circuit breaker.
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Remark: For information about trip commands, see also ╚═▷ “Trip Commands”. For
information about binary outputs, see also ╚═▷ “5.2.5 Output Relays (Binary Outputs)”.
For detailed information about anything, see the Technical Manual.

5.2.12 Switchgear Configuration 2

The single-line diagram (see ╚═▷ “3.9 “CTRL” key – Control Switchgear Devices”, ╚═▷ “Trip
Commands”, ╚═▷ “3.11 Single-Line Diagrams”) shows the switchgear devices and their
positions in a graphical manner: Any change of the position is reflected by a change of
the corresponding symbol of the switchgear. This, however, is only possible if the position
of each switchgear is reported to the protection device by means of an auxiliary contact.
The protection device has to “know” which digital input (╚═▷ “5.2.4 Digital Inputs”) is
related to which switchgear device.

Note that the designation of every switchgear device is also defined in the single-line,
see ╚═▷ “3.11 Single-Line Diagrams”. Not only does the graphical representation depend
on this setting, but also all the menu items related to the switchgear are renamed
accordingly.

This means that instead of the firmware-based menu items [SG[1]], [SG[2]], … the
protection device shows the switchgear names from the single-line, e. g. [QA1], [QA2], …

For the examples throughout this document, we use something like “Qxx” as the
switchgear name.

[1.] Hardware (wiring) work:

At first the switchgear positioning indicators have to be connected to the digital inputs of
the protection device.

For detection of their positions all switchgear devices feature Aux contacts (“Aux ON” and
“Aux OFF”).

In any case, the “Aux ON” must be wired.

The “Aux OFF” contact is strongly recommended to be wired, too, because otherwise, it
would not be possible to detect intermediate and disturbed positions.

This results in an assignment of position indicators to the connected digital inputs, which
is then configured in the settings of the protection device.

[2.] Configuration work:

For every switchgear device “Qx”, enter the menu branch [Control / SG / Qx / Pos
Indicatrs Wirng] and set the parameters »Aux ON« and »Aux OFF« to the connected
digital inputs.

(Remark: The designations “Qx” depend on the settings that you have made in the single-
line, see ╚═▷ “3.11 Single-Line Diagrams”.)

For example, if the digital input number 1 of slot number 1 receives an “active” signal as
soon as the switchgear is in “ON” position, then set »Aux ON« = “DI Slot X1 . DI 1”.

And if the digital input number 2 of slot number 1 receives an “active” signal as soon as
the switchgear is in “OFF” position, then set »Aux OFF« = “DI Slot X1 . DI 2”.
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These inputs “Aux ON” and “Aux OFF” are monitored also with respect to time: If it takes a
switchgear device more time to operate than is acceptable (or if the “Aux ON/OFF” signals
contradict each other) then the protection device assumes that it is disturbed. (This is
signaled via the output signal [Operation / Status Display / Control / Qx] »Pos Disturb«.)
Of course, the protection device needs to know for each switchgear devices what the
acceptable times are.

For every switchgear device “Qx”, enter the menu branch [Control / SG / Qx / General
Settings] and set the time »t-Move ON« to move to the ON position, and the time »t-Move
OFF« to move to the OFF position.

Have a look at the other settings in the menu branch [Control / SG / Qx / General
Settings], too. Depending on the switchgear type it can be necessary to set these as well.
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